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INTRODUCTION 

In the tutorial manual discusses the general features of practical work and the 

main theoretical foundations of the medical devices and systems mechanical 

components design, as well as the main components of the interface in the 

FreeCAD modeling environment. The theoretical and practical results of a computer 

workshop in FreeCAD can be used for the design and operation of medical devices. 

The practical part is aimed to scientific and analytical review, design and 

construction of medical devices, computer modeling of medical diagnostic and 

medical equipment. 

Despite of the FreeCAD system was primarily created for parametric 3D 

modeling in the field of mechanical engineering, but this is not the only direction of 

its application. The FreeCAD workshop developed for supports the application of 

the system in the biomedical engineering field in cases where you want to model 

three-dimensional objects with a given accuracy and control. 

To master the developed workshop, it is recommended to study the FreeCAD 

manual in advance. The design experience in FreeCAD involves the acquisition of 

parametric 3D modeling skills that allow you to create and process objects. 

Applying 3D models to components of medical devices and systems provides 

an advantage that is easy to change your projects during modeling. The use of open-

source principles in the FreeCAD environment allows free use of existing 3D 

models. In this tutorial, which consists of computer workshops on FreeCAD, you 

will learn the basic commands and tools for visualizing your ideas and their 

subsequent implementation. 
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SECTION 1. SOFTWARE FOR PARAMETRIC MODELING 

1.1. Parametric modeling 

FreeCAD software is designed for parametric 3D modeling, like other 

CAD, designed for the creation and processing of solid objects. Its advantage 

is the ease of modifying your projects during modeling, as well as the 

principles of open source and, of course, the possibility of free use. 

One of the most powerful features of FreeCAD is the scripting 

environment. Almost all parts of FreeCAD can be accessed from the built-in 

Python console (or from any other external Python script): creating and 

modifying geometry, changing the display of objects on the screen, and 

accessing and modifying the interface. Scripts can be used in macros, which 

let us easy to create your own commands. 

In this FreeCAD workshop, you will learn the basic commands and tools 

for visualizing your ideas and further implementing them using 3D printing 

"for some tasks and applications that are not relevant at the moment" [1]. We 

will create simple objects step by step. Finally, you will be able to create the 

first 3D CAD model by yoursel.  

In the FreeCAD workshop, you will get the basics knowledge of the 

working with this system. To do this, you need to download and install 

FreeCAD first. You can download it from the FreeCAD website. The 

platforms available are Windows (32-bit, 64-bit), Mac (64-bit), and Linux (64-

bit AppImage). Installing and configuring FreeCAD on the Windows platform 

is shown in Figure 1. 
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Figure 1 – FreeCAD loading window 

 

The basic concept of the FreeCAD interface is to divide it into 

workbenches. Workbenches are a set of tools tailored for a particular task, 

such as working with grids, or drawing 2D objects, or sketches with guides. 

The current workbench can be switched using the workbench selector. It is 

possible to customize the tools of each Workbench, add them from another 

workbench. PartDesign and Part workbenches are widely used as starting 

points. 

The FreeCAD system has two types of extensions: 

1. Macros are small chunks of Python code that provide additional 

tools or functionality. Macros are intended to simplify or automate the task 

of drawing or editing individual objects. If many of these macros are 

gathered in a directory, the entire directory could be like a new workbench. 

2. Third Party Workbenches - A collection of tools, programmed in 

Python or C ++, that significantly extend FreeCAD. If a workbench is 
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successfully designed and well documented, it can be turned on by one of 

FreeCAD's workbenches. 

Each interface tool has the most used tools to execute a specific task: 

 

 

Figure 2 – Interface overview 

 

The main elements of the interface are: 

1. Main view - may contain various tabbed windows, in this case the 

3D view tab is open. 

2. Tabs of the main view - a list of all open objects and documents in the 

form of tabs. 

3. Project tree (part of the combo panel) - showing the hierarchy and 

history of the design of objects in the document, can also display the taskbar 

of active commands. 

4. Properties editor (part of the combo panel) - allows you to view and 

change the properties of the selected objects. 
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5. Selection view - displays objects or elements of selected objects 

(vertices, edges, faces).  

6. Report (or Python output window) - this panel displays messages, 

warnings, and errors in the work in the FreeCAD system. 

7. Python Console - a console for entering Python code and viewing 

the results of its execution. 

8. Status bar - displays some messages and tips. 

9. Toolbars section - the area where toolbars are located. 

10. Workbench Switch - Allows you to switch the workbench. 

11. Standard menu - contains basic operations. 

 

1.2.  Units 

Before you start building your project, you need to decide which units you are 

going to use. We will work using the metric system. 

When you open FreeCAD, you should see the start window (Figure 3): 

In the Units tab you can specify the following: 

User system: selection of a unit system that should be used for all parts 

of FreeCAD 

Number of decimals: the number of decimals that should be shown for 

numbers and dimensions in FreeCAD 

Minimum fractional inch: Minimum fractional inch that should be 

displayed. This setting is only available if the unit system Building US (ft-

in/sqft/cuft) is used. 
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 Figure 3 – Getting Started Window 

 

FreeCAD allows you to work with the major OSE formats and tools that 

focus on the using of an open-source drawings for global replication. 

 

 

SECTION 2. CREATION AND CONFIGURATION OF THE 

PROJECT 

 

FreeCAD uses the concept of workbenches, where each workbench is 

responsible for its specific tasks and functions. The workbench can have its own 

settings section. Initially, there are four sections available in the Edit-

>Preferences  (even if no workbench has been loaded). These are the sections: 

"General", "Display", "Import/Export" "Start", “Part Design”, “Sketcher”, “FEM” 

and “Draft”. Workbenches that can be loaded in the process have their own 

settings tab and will be discussed further. 
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2.1. Creating a new project 

Click “Create new” . 

You can now set your preferred navigation style. For this we will use 

Blender. Rightclick > Navigation styles > Blender> (Right Click > 

Navigation Styles> Blender) (Figure 4). 

 

Figure 4 – Navigation styles window 

 

Changing the units of measurement in the FreeCAD system: 

1. Select and click the Edit> Preferences menu (Figure 5). 
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Figure 5 – Preferences window 

 

2. Select General in the appeared window (Figure 6): 

 

Figure 6 – Working with an option General 

 

3. Go to the "Units" section, change the user system to "Standart" and 
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confirm by clicking "OK" (Figure 7). 

 
 

Figure 7 – Working with an option Units 

 

2.2. View 

Now start a new document by pressing CTRL + N. You will see a 

new, unnamed tab opening at the bottom left of the window (Figure 8). 

If the Combo View on the left is already open, you can skip the next step. 

Open the Combo View by clicking View> Panels> Combo View 

(Figure 9). 

This window is very useful for quickly executing commands. It also 

contains a view Tree and Property, that allows you to become more familiar with 

the structure of your project. 
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Figure 8 – Create a new document 

 

 

Figure 9 – Working with the Combo View 
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2.3. Sketch 

To build a 3D object, you first need to sketch the base: 

1. Change the Workbox from Start to Part Design. This will activate the 

Create Sketch option in the Task Slide in the Combo View window (Figure 10). 

Figure 10 – Work with an option Part Design 

 

2. Make sure you are under the taskbar in Combo View. Click Create body 

and then Create sketch. A new window will open for selecting the orientation 

of the sketch (Figure 11 and Figure 12). 
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Figure 11 – Window with body creation 

 
 

Figure 12 – Working with sketch creation 

 

3. Choose a tool XY-Plane. In the latest edition FreeCAD you can 

continue by simply clicking (Figures 13 and 14). 
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Figure 13 – Working with a cube XY-Plane 

 

Figure 14 – Working with a XY-Plane 

 

If you have an older version, uncheck the reverse direction and zero the 

offset. In this window, the Cube will show you the selected plane on the right. The 
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reverse direction option will switch to the opposite plane. With the Offset option, 

you can change the height of the plane. Click OK to continue (Figure 15). 

 
 

 

Figure 15 – Offset option of the plane window 

 

4. New options have appeared under the taskbar. Here we can change the 

properties of the grid. Check all the grid parameters and set the grid size to 

10 mm. Unchecking the “Show grid” checkbox will hide\open the grid, and 

the “Grid size” will change its spacing. Selecting “Grid Snap” 

automatically snaps the point to the nearest intersection (Figure 16). 

5. Select the Create a Rectangle sketch tool. When you hover your cursor 

over a coordinate system, you can see the current coordinates right next to 

your cursor. Click on the IV quadrant of the coordinate system (lower right 

quadrant) at point 40.0, -40.0 (Figure 17, 18). 
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Figure 16 – Working with a Grid option 

 

 

Figure 17 – Create a Rectangle  

6. You may also notice how the points snap to the grid to make your work 

more accuracy. Make your rectangle 80.0 x 80.0 (drag the rectangle to - 40.0, 

40.0). 
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Set the grid options and select draw rectangle (Figure 18). 

 

 

 Figure 18 –Grid options and draw rectangle 

 

FreeCAD automatically sets constraints on your sketch, as you can see in the 

“Constraints” window on the left. Click “Close” to exit the sketch. You can now 

extrude (Pad option) the sketch into a 3D object. 

 

2.4. Setting new points 

1. Select the Pad command in the Task section of the Combo View (Figure 

19). 

Note: If you don't see these options, go back to the model, and select Sketch. 

Then go to the Task tab. 

 

2. Set the length to 60 mm in the Dimension tab and uncheck Symmetric to 

plane and Reversed. The length will determine how far your object is extruded. 

The Reversed option will stretch the sketch in the opposite direction (Figure 20). 
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Figure 19 – Working with the Pad command 

 

Figure 20 – Working with the Reversed option 

 

Length 2 will be included by switching the “Two dimensions” tab and will 

extrude the object from both sides (Figure 21). 
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Figure 21 – Working with dimensions  

 

We will not use this function for our model. Go back to the 1st 

dimension and click OK. 

 

2.5. Moving objects 

Moving objects has different points of view: 1 - isometric projection, 2 

- front view of the object. 

You can also move the object and look at it from different sides. 

1. By holding down the middle mouse button and moving it, you will 

rotate the object. Note that this feature is available after right-

clicking and selecting Blender under Navigation Styles. 

2. You can also choose different viewing angles. The different views 

can be found in the center line of the FreeCAD toolbar. 

Axiometric View projects an object in 3D. You can also choose one 
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specific side. 

3. If you have lost track of your subject, click the zoom to the left of 

the viewer toolbar. This will scale your entire project. 

 

Self-study Task: 

1. Create a drawing of typical part 1 (Figure 22): 

 

Figure 22 – Typical part 1 

 

Control questions: 

1. What is FreeCAD system? 

2. What kind of modeling is it intended for? 

3. What units of measurement does the system operate with? 
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SECTION 3. A SIMPLE PART CREATION 

PartDesign and Part workbenches are widely used as starting points for 

working with three-dimensional objects. The PartDesign workbench is 

designed to create complex objects, starting with simple shapes, to which 

features are added and removed until the final object is obtained. All elements 

that are added during modeling are saved in a separate view, called the project 

tree, which also contains other objects in your document. The PartDesign 

object can be thought of as a series of operations applied to the results of the 

previous ones, creating one large chain. 

Draft and Arch workbenches operate slightly differently, although they 

follow the general rules for FreeCAD. Sketcher and PartDesign workbenches 

are designed primarily for designing unified parts, while Draft and Arch 

workbenches for working with a few simple objects. The Draft workbench 

provides 2D tools. Most of the Draft workbench tools work not only on a 

plane, but also in volume, and benefit from special assistance systems such as 

plane selection and snapping to objects. The Arch Workbench adds a BIM tool 

to FreeCAD that allows you to create architectural models through parametric 

objects. The Arch workbench depends on other modules like Draft and 

Sketcher. All Draft tools are also available in the Arch workbench, and most 

Arch tools use the Draft workbench support systems. 

In this lesson, you will use the part construction tools to create the 3D 

solid model of the part shown below in the Drawing module. You will start by 

creating a basic shape from a base sketch, and then create a part adding the 

necessary elements. These elements will either add material to the solid or 

remove it from the solid using additional sketches and appropriate operations. 

This lesson will not use all the functions and tools that are available for 

developing parts, but they will be enough to provide a foundation for creating a 

simple part on which you can develop your knowledge and skills. 
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3.1. Workbench Tools (Part Design) 

First, make sure you are on the Part Design workbench menu. Once you've 

done this, create a new document if you haven't already. It's a good habit to save 

your work often, so first, save the new document with any name you want. 

Part Design begins by creating the body of the object. We will then build 

the base of the solid, starting with a sketch. 

1. Click on  "Create New Body" to create and activate a new body 

container. When sketching, if no existing body is found, a new body will be 

automatically created and activated. 

2. Click on  “Create New Sketch”. This will create a sketch in the 

body you just created. 

3. We need to define where the sketch will be attached. We will attach 

it to the plane of the Origin body. 

On the "Tasks" tab in the combo panel, select "YZ_Plane" (Figure 23) 

in the list and click OK. 

 

Note: If the OK button is not visible, you can make the sidebar wider by 

dragging the right border. Put mouse cursor over the border; when the pointer 

changes to a double-headed arrow, press and hold the left mouse button and drag. 

 

When you click OK, FreeCAD will automatically switch to the Sketcher 

Workbench and open the sketch for editing (Figure 24): 
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Figure 23 – Combo View Window Tabs 

 

 

Figure 24 - Sketcher Workbench 
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Next, you can use the Polyline tool  and create a new shape. It doesn't 

have to be perfect, as the final shape will be constrained. Once you get the basic 

shape, we'll start applying constraints. If you have the Auto Constraints option 

enabled, some of the constraints will be applied automatically, if not, follow 

these steps. But first make sure you exit the polyline construction tool by double-

clicking the right mouse button or pressing ESC; the mouse cursor should return 

from the crosshair to the standard arrow cursor. 

Note: Do not press ESC a third time, otherwise you will exit sketch editing 

mode; if this happens, click on the "Model" tab, then in the tree of elements, 

double-click on the Sketch, or right-click and select "Edit Sketch" from the 

context menu. 

 

To edit a sketch, follow these steps: 

 

1. Select with the mouse two horizontal lines by clicking on them, and 

after selection click on  the horizontal constraints 

2. Select the vertical line on the right and then click on  the vertical 

constraint. 

3. Select the start and end points of your polyline and click on  

"Coincident " selected. 

4. Select the bottom horizontal line and the right vertical line and set  

the “Equal” between the two lines. 

5. Select a horizontal or vertical line and set the appropriate  

horizontal or  vertical distance by setting the value to 26 mm. 

6. Select the top horizontal line and set the horizontal dimension by setting 
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it to 5 mm. 

7. Select the bottom-right point of the horizontal Start line, and then the 

center point of the grid, and apply  a merge of points to fix your shape. 

At this point, you should have a fully constrained sketch, as indicated by 

its color change and the message displayed in the combo panel. 

The sketch should now look like Figure 25. 

 

 

Figure 25 - Sketch of a figure 

 

Next, in the editor's combo view, click the Close button, and to exit the sketch 

editing mode, select  Pad from the toolbar or from the Part Design menu. 

This will open the Pad dialog box in the combo panel. Using this dialog, first 

use the Type drop-down menu to select two dimensions: the part length is 53 mm. 
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You will do this by extruding (Pad command) our sketch to both sides of the center 

plane to get this distance, i.e., extrude symmetrically to the location of the sketch 

plane. 

Now, if you want the length to be 53 mm, enter 26.5 for the length and 26.5 

for the second length. Alternatively, you can specify a single length of 53 mm and 

select the “Symmetrical Plane” checkbox. Once this is done, you will have a base 

on which to add additional elements to build your part. 

 

3.2. Applying the Pocket and External Geometry functions 

Using the mouse or the view button, you can rotate the model to see its rear 

side. Once the rear face of the part is visible, select the face by clicking on it, as 

shown in the following Figure 26. 

 

 

Figure 26 - Rear face of the part 
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After selecting a face, click on the “New Sketch” icon in the toolbar or in the 

“Part Design” menu and this will place your next sketch on the rear face of the part. 

Now select the next   “Rectangle” tool and place the rectangle on the rear face 

in the same way as shown below. 

Follow the steps listed to constrain the sketch: 

1. Select one of the horizontal lines, set the horizontal dimension and set the 

value to 5 mm. 

2. Select one of the vertical lines and set its vertical dimension to 11 mm. 

3. Select  the “External Geometry” tool. 

4. Select the top right point of the face and click on it to get a point from the 

external geometry to link our sketch to it (Figure 27). 

 

 

Figure 27 - Application of the tool "External geometry" 
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5. Click the right mouse button to exit the External Geometry mode. 

6. Select the point you just made available with the External Geometry tool, 

then select the top-right point of the rectangle and merge the selected points. 

 

At this stage, the sketch should be completely constrained and look like the 

one shown in Figure 28. 

 

 

Figure 28 - Sketch after "constraint" 

 

Once this is done, click the “Close” button at the top of the “Tasks” tab in 

the combo window, then select the “Pocket”  tool from the toolbar or from 

the “Part Design” menu. The action of this tool is the opposite of the “Pad” tool. 

The “Pad” tool adds material to the part, the “Pocket” tool removes material 

from the part. Both operations are functions. In this cut operation, we need to 

select “Through” from the Type drop-down menu and then click OK. 
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For the next step, make sure the “Pocket” tool is selected in the Model 

Tree View, and only then click the  “Mirrored Feature” tool from the 

toolbar or from the “Part Design” menu. In the “Mirrored Transform” dialog 

in the combo panel, select “Horizontal Sketch Axis” from the Plane drop-down 

menu. Then click OK. 

“Mirrored” works this way because the base element of your model was 

extruded (Pad command) to either side of the horizontal plane in the first base 

sketch operation. If everything went well, you should now have a detail like 

Figure 29 after you rotate it to face first. 

 

 

Figure 29 – Using the " Mirrored" function 

 

3.3. Pad and External Geometry applying function 

After inspecting, flip the part back and select the Rear Face of the part again 

to place the next sketch on it. 
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Figure 30 - Rear face of the part 

 

Select New Sketch and create a new rectangle in the same manner as shown 

in the image below. Then set dimensions of the rectangle. 

1. Select the horizontal line and set the horizontal dimension by setting the 

value to 16.7 mm. 

2. Select the vertical line and set the vertical dimension by setting the value to 

7 mm. 

3. Using the “External Geometry” tool, select the top-left point of the part 

face. 
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Figure 31 – Using the External Geometry tool 

 

Now with the top-left point of the rectangle and the external geometric point 

selected, merge (“Coincident”) the selected points to completely constrain the 

sketch. 

 

Figure 32 – Coincidenting selected points 
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Next, click on the "Pad" function and in the Pad dialog box in the 

ComboView panel, set the length to 26 mm, setting the Type field to dimension, 

and then check the "B" checkbox for the reverse side. Using the B flag on the 

reverse side will cause the extrusion to go into the part, not away from it. This 

operation will produce the following result: 

 

 

Figure 33 – Using the "Pad" function 

 

Use the “Mirrored Feature” again to create a second extrusion (Pad 

command). First, make sure the extrusion you created is selected in the Model Tree, 

then click “Mirrored Feature” in the toolbar or select it from the “Part Design” 

menu. Repeat the operation you used for the cut above and select “Horizontal 

Sketch Axis” from the “Plane” field drop-down menu. 
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Figure 34 – Using the Element of “Mirrored feature” 

 

3.4. Constraint and external geometry function 

Sketcher's "constraint" functions allow you to define exact geometric 

dimensions for shapes by defining lengths, angles, and ratios (horizontal, vertical, 

perpendicular, etc.). The “constraint” solver interactively calculates the degrees of 

freedom constraints of the sketch geometry. 

Most CAD models are based on a plane 2D sketch, since a 2D sketch can be 

"extruded" (“Pad” option) to create 3D shapes; 2D sketches can be used to create 

other features, such as cutouts, ridges, or "add-ons" over previously drawn 

volumetric shapes. 

At this point, as you rotate the part around the face, you can see that it starts 

to look like the part in the dimensional drawing as at the beginning of this tutorial. 

Once you see the front of the part, click on the angled face to select it for the next 

sketch. 
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Figure 35 - Workpiece part 

 

Here you will use the “Rectangle” Tool and place a rectangle in your sketch, 

and then apply the following constraints: 

1. Select the horizontal line and vertical line, and after both are selected, set 

"Equal". 

2. Select a horizontal or vertical line and set the appropriate horizontal or 

vertical dimension with a value of 17 mm. 

3. Using the External Geometry tool, select the top right point as shown in the 

Figure 36. 
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Figure 36 – Using the External Geometry tool 

 

Now, using the dimensions from the drawing, apply the following constraints: 

1. Select the external geometry point and the top-right point of the square and 

set the horizontal dimension to 7 mm. 

2. Select the external geometry point and the top-right point of the square and 

set the vertical dimension to 11 mm. 

 

The result should be as follows (Figure 37): 
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Figure 37 – Setting the dimensions of the part 

 

For now, if you just cut out this sketch, the resulting hole will be 

perpendicular to the sloped face it was drawn on, and this is not what you want. 

 

Figure 38 – Pockets in the workpiece part 
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You need the created pocket to be perpendicular to the rear face, but its 

projected dimensions do not match the 17 x 17 mm shown in the drawing. You can 

calculate the required size, or you can use the tools provided by FreeCAD to make 

these calculations. 

To create a slanted rectangle cutout at the exit, you need to draw a new 

rectangle on the rear face using the slanted rectangle's projection as an outer 

reference. Rotate the solid to see the rear face of the part again and select it to place 

the final sketch. 

 

 

Figure 39 – Final sketch 

 

Select “New Sketch” from the toolbar or the “Part Design” menu. Now, in 

sketch edit mode, you do not see the drawn rectangle on the slope. To be able to 

select it, switch the combo panel to the model tab and select the last sketch made on 

the oblique face. Then, using the spacebar, make it visible. Next, select the element 

"Symmetries" and again, using the space bar, hide it. You should now be able to see 

a slanted rectangle inside the 3D view. You can continue working with the “Model” 
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tab visible, or return to the “Tasks” tab. Using the “External Geometry” tool, select 

the top and bottom edges of the slanted rectangle. Then add a new rectangle to the 

sketch using the “Rectangle” tool: 

 

 

Figure 40 – Using the "Rectangle" tool 

 

1. Select the top-left point of the new rectangle and the top-left point of the 

external geometry and merge them. 

2. Click on the bottom-right point of the new rectangle and the bottom-right 

point of the external geometry and merge them. 

 

As a result, we get a closed loop| contour (Figure 41): 
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Figure 41 – Closed loop 

 

Next, close the sketch using the close button or complete editing from the 

Sketch context menu, and then select the “Pocket” tool from the toolbar or from the 

“Part Design” context menu. In the drop-down menu of the “Type” field, select 

“Through all” and click OK. 

 

 

Figure 42 – Using the "Pocket" tool 
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At this point, you can see the lines that appear due to the crossing elements. 

The side block intersects with the base profile, forming a triangular block above the 

profile (these are the additional lines visible in the picture above on the right side of 

the model). 

To remove these lines, you can turn on "Shape Refinement" in the Part 

Design preferences. Set the Refine Property to TRUE for the Pocket properties to 

do the cleanup: 

 

 

Figure 43 – Turning on the “Shape Refinement” of the part 

 

To save time in the speed of processing the sketch of the part and save these 

lines for design, it is possible to individually include them for each function that 

creates such lines. 

 

You can configure object property values on the Data tab in the Model combo 

panel menu. 
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Figure 44 – The final model of the part 

 

Self-study Task: 

1. Create the final model of the part (Figure 44); 

1. Create a drawing of typical part 2 (Figure 45) 

 

Figure 45 - Drawing of a typical part 2 
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Control questions: 

1. What Part Design tools are used for design? 

2. Does the Pad function apply to external geometry? 

3. Does the Pocket function apply to the external geometry? 

 

SECTION 4. WORK WITH 3D-OBJECTS 

4.1. Toolbars and navigation 

Let's start the editor and configure it to work. First, select the desktop: 

View> Workspace> Part (Figure 46). 

 

 Figure 46 – Desktop setup 

 

Let's create a new file, on the left we will see the windows of the document 

tree, the properties view and the Combo View. Close by clicking the mouse in 

the upper right corner of the document tree window and view of properties, 

leaving only the combo panel. Then click File-> Save As, save the project under 
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the name "Test".  

The desktop is ready for use (Figure 47). 

 

Figure 47 –New file creating 

 

Now let's look at the tools we will use. 

They are located at the top of the window. 

The first group of tools is the standard views (Figure 48). 

With their help, we will be able to switch between views and 

projections. 
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Figure 48 – Standard views 

 

From left to right: 

 Axonometric View, Front View, Top View, and so on. You can also 

switch between standard views using the Numpad keys: 0 - axonometry, 1 - 

front view, 2 - top view, etc. 

 

The second group of tools is the panel of basic shapes (primitives) 

(Figure 49). 

 

 

Figure 49 – Basic shapes 

 

As you can see, there are three-dimensional shapes: Cube, Cylinder, 

Sphere, Cone, Torus, as well as the button for creating primitives. With 

these tools, you can create the corresponding objects. Click on the "Cylinder" 

button (Figure 50). 
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 Figure 50 – Element Cylinder 

 

A cylinder appears on the working area, and a tree appears in the 

"model" window on the left, at the top is the name of the model, which 

includes the cylinder. 

Let's practice switching model views, top, front, return the axonometric 

view. Now let's look at how navigation is carried out using the mouse (Figure 

51). 

 
 

 

Figure 51 – Navigation with the mouse 
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Select - Press the left mouse button over an object you want to select. 

Holding down Ctrl  allows the selection of multiple objects. 

Pan - Hold the middle mouse button, then move the pointer. 

Zoom - Use the mouse wheel to zoom in and out. Clicking the middle 

mouse button re-centers, the view on the location of the cursor. 

Rotate view. First method - Hold the middle mouse button, then press 

and hold the left mouse button, then move the pointer. The cursor location 

when the middle mouse button is pressed determines the center of rotation. 

Rotation works like spinning a ball which rotates around its center. If the 

buttons are released before you stop the mouse motion, the view continues 

spinning, if this is enabled. A double click with the middle mouse button sets a 

new center of rotation. 

Rotate view. Alternate method - Hold the middle mouse button, then 

press and hold the right mouse button, then move the pointer. With this 

method the middle mouse button may be released after the right mouse button 

is held pressed. Users who use the mouse with their right hand may find this 

method easier than the first method. 

 

Let's practice selecting an object, rotating, moving, changing the scale. 

To return the object to the standard view, press the "Axonometric View" 

button. 

 

To implement geometric primitives, use the "Tasks" function in the 

"Create Sketch" menu. As you can see, you can create several different 

shapes in a single object. For example, select a prism from the list and click 

"Create Sketch" and "Close" (Figure 52). 
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Figure 52 – Geometric primitives 

 

As we can see, a prism appeared inside the cylinder. Now let's change 

the parameters of the objects. In the upper window of the Сombo panel, 

select the Cylinder with the left mouse button, in the lower window, select 

the Data tab (Figure 53). 
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Figure 53 – The "Data" tab in the Combo panel 

 

Now in the data window, left click on the value of the Radius 

parameter and type the value of the radius of the cylinder 4.5 mm on the 

keyboard. Left click on the value of the Height parameter and enter the value 

of 5.5 mm. As we can see, the dimensions of the cylinder on the working 

field have changed (Figure 54). 

Now select the prism at the top of the Сombo panel. 

Important: it is necessary to remember to select in this window the 

object with which it is supposed to work because all parameters, the sizes, a 

location will change in a data window for the selected object. 
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Figure 54 – Resize the Cylinder 

 

For a prism, first change the number of faces. To do this, left click on 

the value of the Polygon parameter and enter the value 5. 

Next, change the position of the prism. To do this, at the bottom of the 

panel, left click on the value of Placement and click on the small button that 

appears on the right side of the window (Figure 55). 

 



54 

 

Figure 55 – Change the objects placement  

 

The window for changing the position of the object has opened. In the 

X coordinate window, we enter -2, in the Y coordinate window we enter -

2.5, which leads to the displacement of the prism along the X and Y axes by 

the corresponding number of millimeters. 

 

Then select the Y-axis parameter from the Axis drop-down list, enter 

an angle of 17 degrees. Click on the "Apply" and "Yes" buttons (Figure 56). 

 

 



55 

 Figure 56 – Changing the object position 

 

Finally, consider the third and final group of tools, of which we will use 

– a group of logical operations with objects (Figure 57). 

 

Figure 57 – Logical operations with objects 

 

From left to right: Boolean operations, Difference, Union, Intersection, 

etc. Let's look at the first 4 operations and start with Union . In the upper 

left window of the Сombo panel, select both shapes, the prism and the 

cylinder, with the shift key pressed. Click on the “Union” button. As a result, 

we got one object – Fusion and the result of adding objects (Figure 58). 
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Figure 58 – Union objects 

 

Now we will undo the last operation by pressing Ctrl + Z. The object 

disappeared from the screen. Figures Prism and Cylinder have appeared in 

the combo panel, but the labels are grayed out. They have become invisible. 

To restore visibility to the object, you need to select the shape in the combo 

panel and press the "space". Do this for both figures. To make an object 

invisible, you need to do the same - select and press the "space". Now, when 

the shapes become visible again, we will apply the operation " Difference ". 

To do this, first select in the Combo panel the figure from which we will 

subtract - Cylinder, then hold down Ctrl, select the figure to be differenced - 
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Prism, click on the subtraction button ("cut two figures") (Figure 59). 

 

  

Figure 59 – Difference two shapes 

 

Rotate the resulting detail with the mouse. As you can see in the 

combo panel window, the result of the Difference two shapes is the cut 

object. Now we will undo the operation again by pressing Ctrl+Z, make the 

shapes visible, and try the "Intersection" operation. To do this, select both 

shapes again and click on the "Intersection of two shapes" button. The 

result of the operation became the Common object. Admire the beveled 

prism by rotating it with the mouse. Undo the operation - Ctrl+Z, making 

both objects visible - select + space. Now let's look at the "Boolean 

Operations". Without selecting any objects, press the button "Perform a 

boolean operation with two selected forms". As you can see on the figure, 
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you can also perform various operations with this tool. For example, in the 

upper part we select the operation - the difference, below in the windows we 

select the first shape by putting a “tick” in front of the prism, in the second 

window we select the second shape - the cylinder (Figure 60). 

 

Figure 60 – Prism with cut 

 

Click on the "Apply" and "Close" buttons. As a result, we got a prism 

from which the middle is cut - this is our Cut object. Now let's try deleting 

shapes. Left click on the Cut object, select "delete". The Cut object 

disappeared, and the Prism and Pyramid reappeared. Let's delete them too, 

save the project and close the program. 
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4.2. Basic cut function 

Set the dimensions of the Pocket function found in the combo view: 

1. Select the top plane by switching to the top view in the view menu 

and clicking on the visible face of your rectangle. 

2. Create a new sketch of the part under Task in the Combo view 

(Figure 61). 

 

Figure 61 – Combo View “Tasks” 

 

3. Set the grid to 5mm and select the Grid Snap. Now draw a rectangle 

starting at -35.0, 35.0 and make it big 70.0 x -70.0. It should offset 5mm 

from the edges of your box. Confirm your changes to the rectangle and close 

the sketch. 

4. Click on the Pocket function just below the Pad function in the 

Combo View to continue. This function will cut everything inside your last 

drawn rectangle. You can change the direction and cut limit in the type 

selection.  

5. Set Type to Size and Length to 55.0 mm for a 5 mm floor thickness. 
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Also rename the created pocket to "Hole" by pressing F2. When you switch 

to isometric view, you can see a hole in the box. 

 

4.3. Offset 

To shift the work plane using the Offset tool, you need to: 

1. 1. To hold the working plane of the future part, you need to 

create a rim around the top of the object. Switch to axonometric view and 

select the top plane of the window (don't select the base or sides of your 

box). Resize the grid to 5mm and turn on grid snapping. Now create a 

rectangle aligned to the top edges of your block, starting at -40, 40.0. 

2. Close the sketch of the part when finished and rename the 

finished sketch to "Rim". To access the Offset tool, switch your desktop 

from Part Design to Draft. 

3. 3. Redefine the work plane by clicking Set Work Plane and then 

at the top plane of the window. The grid should become visible. To show or 

hide the grid, select Draft> Utilities -> Toggle Grid. The height of the work 

plane will determine the drawing level. Creating drawings at different levels 

will allow you to extrude the drawing into a specific object. 

4.  Select the "Rim" sketch in the Model section and the Task 

select the Offset tool. Select the Copy check box to leave "Rim" after the 

offset. 

5. When using the Offset tool, it is very important to move the 

cursor and keep it in the modeling window. You will notice a rectangle 

following your cursor. Now don't move your mouse, enter a value of -2.5 and 

press enter. This will offset your sketch 2.5mm inside. 

6. Turn off the Draft grid and return the work pane back to the part 

design. 
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4.4. Alternative method to trim or subtract from an object 

To trim and subtract objects, you need to: 

1. Double-click the "Rim" sketch to edit it. Set the grid to 2.5mm and 

check the grid snap. 

2. 2. Draw a second rectangle just above the "Draft" starting at (-

37.5, 37.5) with a size of (70.70). Close the sketch. You can now also delete 

the “Draft” by clicking on it and press the delete button. 

3. Select “Rim” again and trim it using the Pocket function. Set the 

type for size and length up to 5mm. This will reduce the space inside the 

rectangles. 

 

Self-study Task: 

1. Create a drawing of part 3 (Figure 62 a); 

2. Create a sketch of part 3 (Figure 62 b): 

 

 

Figure 62 (а) – Sketch of part 3 
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Figure 62 (б) – Part Drawing 3 

 

Test questions: 

1.  List the design toolbars. 

2. List the ways to use the mouse to design 

3. What is the purpose of the Pocket function? 

What is the purpose of the Offset function? 
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SECTION 5. FILLET AND PATTERNS 

This tool creates a fillet for the selected face of an object. The dialog box 

allows you to select an object and faces to process. 

 

5.1. Features of the Pattern 

1. The Pattern function distributes the object equally. Therefore, before you 

can work with an object, you need to create it. In this step, you must add small 

additions to the bottom of the box. Switch your view to bottom view and select a 

visible plane. You should see the bottom of your box. Now create a new sketch on 

this plane and set the grid size to 2.5mm, also check the grid snapping. 

Select Create a Circle and draw a circle in the upper right corner of the box 

with a value of -30.0, 30.0 with a radius of 5 mm. Now close the sketch. 

2. Select the sketch drawn in step 1 and pull it out using the Pad. Set the 

length to 5mm and uncheck Symmetric to Plane and Reverse. Click OK to finish 

and rename Pad to Nub by pressing F2. 

3. Now press Nub again and select the Polar Pattern  function. Set the 

Angle to 360.00, Occurrences to 4, and uncheck the box in the Reverse direction. 

This tool creates a circular model of a part with a specific angle and occurrences. 

The angle determines the size of your drawing. For example, at a 360° angle, 

objects will be positioned in a full circle, at a 90° angle only within a quarter of a 

circle. With the reverse direction check, your drawing will rotate clockwise. 

 

5.2. Fillet function 

Create a fillet from circular overlays with a 2.4mm radius: 

1. Switch to bottom view and select all Nubs. To select many parts, 

hold down the CTRL key and click on different parts. To deselect a part, 

simply click on it again. 
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2. Now select the fillet function . The adjustable radius determines 

the size of your fillet. The radius should be smaller than the object you are 

creating, so set the radius to 4.9mm. Close the function and rename the Fillet 

to " Fill " 

 

5.3. Fillet the corners of a part 

First, create a rectangle on the existing rim. Reduce this by 2.5mm and 

then select the outside edge of your box to create the fillet: 

1. Switch to the top view and create a new sketch on the “Rim” that you 

created in paragraph 4.3 and paragraph 4.4. 

2. Draw a rectangle on the right side starting at 35.0, 37.5 and make it 

large 2.5 x -75.0. Exit the sketch and go to the next step. Create a new pocket 

with a sketch Start Part, set the length to 2.5 mm and uncheck the Reversed 

box. Also rename pocket to “SmallRim”. 

3. Using the tool "Fillet the selected edges of a shape"  in the 

workbench Part round off the edges of the created part. Select the outer edge 

of the “SmallRim” part and click on the Fillet element Set the fillet radius to 

2.4 mm. 

As a result, we get a fillet with a radius of 2.4 mm (Figure 63). 
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Figure 63 – Fillet the selected edges of a shape 

 

Self-study Task: 

1. Fillet the part in the necessary, in your opinion, places for part 4 

(Figure 64): 
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Figure 64 – Part 4 with fillet 

 

Control questions: 

1. List the design toolbars. 

2. List ways to use the mouse for design 

3. What is the purpose of the Fillet function? 

4. What is the purpose of the Offset function? 

 

 

SECTION 6. BENDING, EXTRUSION, CUTTING 

Open a new document and save it as "Box Cover". Then switch your 

Workbox to Part Design. 

 

6.1. Bending and Extruding 

1. Create a new sketch on the XY plane, draw a rectangle starting at -

40.00, 40.00 and make it 80.00 x -80.00. Rename the sketch to "Base". This will be 

a new, independent object. 

2. Now extrude the sketch 5 mm high and rename it to "Base". When done, 

start a new sketch on top of the extruded box. Draw another rectangle starting at -

40.00, 40.00 and make it 80.00 x -40.00big. Rename it to “Base of Revolution”. 
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3. To create a Revolution, first click on "Base of Revolution" and then on 

the Sketch feature. Set the Axis to Horizontal Sketch Axis and the Angle to 180°. 

Uncheck Symmetric to Plane and Reversed. A symmetrical plane will distribute 

the element evenly on each side equally on the plane. 

4. Hide the Revolution you created in step, by clicking on it in the model 

view and pressing the spacebar. Now create a new sketch on top of the Base 

extruder. Set the grid to 2.5mm and draw a rectangle at (-37.50, 37.50) and make it 

large at 75.00 x -37.50. Create a new function Revolution. Set Axis to horizontal 

and angle to 180°, also uncheck Symmetric to Plane and Reversed. 

You can use the model of this object to create a drawing of a part, make the 

object larger, and reduce its placement during 3D printing. 

 

6.2. Cut with two objects 

1. Switch your Workbox to a Part and select Run in Boolean operation. 

Select Difference in the Boolean Operations window. It will take away Second 

Shape from First Shape. Union will combine two objects, Intersection will extract 

the common part of the two objects, and Section will extract the common part of 

the two objects as non-solid. 

2. Choose First Shape for the first Revolution. This must be the biggest 

revolution of the two. Second shape will be smaller revolution. Click Apply to 

confirm the subtraction. 

3. To finish, we create a new sketch at the bottom of the "Base Extrude". 

Draw a rectangle starting at -37.50, 37.50 and make it large at 75.50 x -75.50. Cut 

the sketch to 5 mm using the Slice apart function from the Shape splitting tools. 

 

Self-study Task: 

1. Create an extruded object - Part 4 (Figure 64). 

2. Create an object with a cutout - Part 5 (Figure 65). 
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Figure 65 – Part 5 with an extrusion 

 

 

Figure 66 – Part 6 with cutout 

 

Control questions: 

1. What is the purpose of the Revolution function? 

2. Why is a cutout with two objects made? 

3. How to cutout with two objects? 
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SECTION 7. CREATING AND EDITING OF A MACRO 

Macros are combined commands that are a series of commands or 

keystrokes and can perform multiple recures tasks. You can use macro writing to 

automate tasks, which does not guarantee full-scale script programming. 

 

7.1. Creating a macro 

In FreeCAD, macros are a step-by-step representation of individual 

commands and are stored as a Python script with the * .FCMacro file extension. 

 

Open the Macro toolbar or find the Macro menu item (Figure 67). 

 

 

Figure 67 – Macro recording menu 

 

To record a macro, follow these steps: 

1. Press the red button to record the original macro: 

                                 

 

2. The Macro Recording dialog box appears. Give the macro a name and save 

it: 
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Figure 68 – Macro recording window 

 

3. Write down the macro for the sketch of part 3 (Figure 62) and change its 

width to 20 mm. 

4 When the task for the script is finished, press the green button to stop 

recording: 

 

 

5. Execute the macro by pressing a button that looks like a keyboard 

thumbnail: 

 

 

 

6. Select the name of the macro you created and click on Execute (Figure 

69): 
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Figure 69 – Macro execution window 

 

To change where macros are stored, open General Settings by clicking Edit-> 

Preferences-> General, and then clicking the Macro tab. From the Macro 

recording settings menu, select Macro path and specify the valid path to the 

directory of files with them, or click on the button to the right of the Macro path 

and correct it to the valid directory name. 

 

7.2. Using and editing macros 

Since macros are really a list of Python commands, you can edit them and 

create very complex scripts. You just need to record your actions on the object as 

you do them, and then save and replay them when necessary. 

We could read and edit macro entries that contain Python instructions. To 

edit, open the created macro with the Edit button in the macro dialog. This feature 

opens our macro in the built-in FreeCAD macro editor. 

The following is a Python macro code: 

 

# Macro Begin: /home/freecad/10x10x20mm box.FCMacro ++ 
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import FreeCAD 

import Part 

 

#Gui.activateWorkbench("PartWorkbench") 

App.ActiveDocument.addObject("Part::Box","Box") 

#App.ActiveDocument.recompute() 

#Gui.SendMsgToActiveView("ViewFit") 

FreeCAD.getDocument("Unnamed").getObject("Box").Width = 20.00 

 

# Macro End: /home/freecad/10x10x20mm box.FCMacro ++ 

 

Entries beginning with # are not executed in FreeCAD; they are comments in 

Python. Comments help us understand what is happening in the code. 

The executable lines of code that run are as follows: 

 

import FreeCAD 

import Part 

App.ActiveDocument.addObject("Part::Box","Box") 

FreeCAD.getDocument("Unnamed").getObject("Box").Width = 20.00 

 

Operators that start with import open the basic modules that are needed to 

execute our macro. The Import Part feature allows us to create geometric objects 

such as boxes, cylinders, spheres, and many other 3D objects. 

For example, the boxing feature looks like this: 

 

 App.ActiveDocument.addObject("Part::Box","Box")   

 

You could edit macros to program what they didn't do originally. Open the 

macro in the built-in FreeCAD editor by clicking a button that looks like a text 

editing pad. Select the macro, and then click Edit. 
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You can also change parameter values for different objects. In our created 

macro, you can change the following two functions to get a different name and 

object length: 

 

App.ActiveDocument.addObject("Part::Box","newbox") 

FreeCAD.getDocument("Unnamed").getObject("newbox").Width=20.5 

 

You can save changes after editing by selecting File-> Save from the top 

menu. You can then press the green play button to run the modified macro: 

 

                                        

 

So, when performing tasks, each macro corresponds to Python commands 

that run in the background. The FreeCAD macro just captures this sequence of 

commands and saves them to a file that you can reuse. 

 

Control questions: 

1. Purpose of macros? 

2. How is a macro created? 

3. How is a macro edited and executed? 
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CONCLUSION 

Thanks to the latest advances in both CAD and medical technology, CAD is 

increasingly used in medical applications and devices. In particular, CAD and 3D 

printing technologies are used in biomedical engineering, clinical medicine, 

individual medical implants, tissue engineering, dentistry, artificial joints and 

robotic surgery. 

Medical technology is often complex, with many individual components 

interconnected to achieve a specific function. In addition, such machines must be 

designed and constructed very precisely, as design errors can lead to the failure of 

the functionality that these machines have to offer. 

The fundamental advantages of CAD have made it an ideal solution for the 

revolution in the design of medical devices, such as microarrays, MRI machines and 

more. An experienced professional can create models of medical equipment that 

meet the specific measurements and requirements specified in the specifications. 

By the time the product passes the modeling phase and is built, the result 

must be extremely accurate, as described in the initial specifications. Therefore, 

research and study in this area provides an opportunity to become a master in the 

field of accurate digital modeling, which creates medical machines that save lives. 
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